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Introduction
Oracle VueLink for Documentum provides an interface between the Documentum Webtop and the AutoVue family 
of products. This interface enables you to add powerful Viewing and Markup capabilities to your Documentum 
Webtop via Web browser in an intranet or the Internet.

VueLink and AutoVue provide you with the following functionality:

• Document viewing of native formats.
• Graphically marking up documents using a rich set of graphical and textual tools.
• Reviewing your markups and the markups of your coworkers.
• Create a Mobile Pack for a file that can include all the resources and associated markups.
• Full security linking to the Docbase access control list (ACL).

Note: 
• Throughout this manual the family of AutoVue Products is referred to as AutoVue. The AutoVue family of 

products includes AutoVue Office, AutoVue 2D Professional, AutoVue 3D Professional Advanced, AutoVue 
EDA Professional, and AutoVue Electro-Mechanical Professional. 

• Refer to the AutoVue Supported File Formats document for further information about the specific features and 
file formats supported by each AutoVue product.

Functional Overview
Oracle VueLink for Documentum adds document viewing and markup capabilities to Documentum Webtop. It 
provides a seamless user interface between Webtop clients and AutoVue. All Webtop clients are supported via a Web 
browser in an intranet/Internet environment. Markups are automatically saved on the Docbase server and are 
available for other users to edit or view depending on their document access level.

VueLink and AutoVue provide users with the following powerful features and capabilities via a Web browser:

• Securely view documents in their native format without editing them.
• View hundreds of 2D and 3D Engineering and Business document formats.
• View multi-content objects.
• Simultaneously work with multiple Markup layers and files.
• Create a Mobile Pack for a file that can include all the resources and associated markups.
• Create markups directly on stored documents or renditions using a rich set of annotation tools.
• Create hyperlink connections to other related documents.
• Consolidate several Markup files (perhaps from different reviewers) into a single Markup file.
• Control access to Regular, Read only, Master and Consolidated Markup files.
• Associate markups with a specific document revision. Markups may be migrated to new revisions as required.
• Graphically compare different revisions of engineering drawings.
• Print documents with header, footers and watermark information queried from specified document attributes.
• Create and store Adobe Acrobat PDF renditions of documents and associated Markups directly from your 

workstation.

Oracle VueLink for Documentum also provides you with a basis to which other powerful functions can be added via 
custom designed tools to further enhance your Documentum installation. Custom designed tools offer many 
possibilities. For example, you can create 'intelligent' custom stamps such as an engineering stamp that queries for 
information that could be included as Markups.
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In addition, custom applications can be created to extract relevant information from an AutoCAD or MicroStation 
file, and automatically link it with information from your Documentum Docbase or other system. This brings the 
concept of intelligent drawings to a new level. All these features are available from your Web browser by using the 
AutoVue Client/Server Deployment.

AutoVue is fully configurable for you to customize your own tools. If you prefer, contact your account manager or 
our technical support representatives to discuss the possibilities of us designing a tool to meet your specific needs.

Why Does the Documentum User Need a Viewing 
and Markup tool?
Typically in an organization, a document has a life cycle and is routed to several people as part of a workflow cycle. 
At minimum, there are three types of people that interact with a document:

Creator/Author of a document: The creator is usually the person responsible for creating or modifying a document 
with an editing application such as Microsoft Word or AutoCAD.

Reviewer of document: This individual usually reviews a document and provides comments to the author or other 
reviewer. In a paper-based environment, the document would be printed and sent to a list of reviewers. Each reviewer 
would provide feedback in several ways, directly annotate the paper output using a pen, attach sticky notes to the 
paper output, and create one or more annotation documents. The annotated document along with other material is 
then sent to a supervisor who will review the material, possibly from several reviewers and may consolidate the 
comments into one set. This set is then passed back to the creator for making modifications to the document. Several 
revisions, or versions of the document may be produced during this process.

Users of documents: Once the review cycle is complete, possibly involving several versions of the document, the 
document is published. The final document is made available to those requiring View only access to the document. At 
this stage, the document may be provided for viewing either in its native format or as a print rendition.

Oracle VueLink for Documentum provides the capability of marking up a document and storing Markup information 
in an annotation file in the Docbase server. There are different types of Markup entities offered in addition to 
hyperlink capabilities.

Markup File Management
More than one Markup file can be attached to a document or a rendition. In addition, users have the option of 
displaying one or more Markup files simultaneously. If the currently displayed document has registered Markups, a 

Markup Indicator  displays in the lower left corner of the status bar alerting the user to the existence of one or 
more Markup files. Markup files also automatically track the revisions of a document so that each revision has a 
distinct set of related Markup files. When Markups are valid for a subsequent revision they can be promoted to that 
revision.

Other Useful Features
Compare
With the Compare feature, documents of the same type (raster or vector) are visually compared. The two selected 
files are simultaneously displayed in their own windows with the comparison findings displayed in a third viewing 
window. This feature is very useful for finding similarities and differences in revisions of a drawing.
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Conversion
Documents can be converted from any of the AutoVue supported file formats to some popular graphics formats such 
as TIFF and BMP.

Engineering Documents
Oracle VueLink for Documentum is fully equipped to handle complex engineering documents that may consist of 
external references (XRefs), layers and blocks.

Streaming Files
With AutoVue it is possible to enhance the viewing performance of large drawings by using cached streaming files. A 
streaming file is a lightweight format developed by Oracle and represents a true replica of the original format.

When viewing a file, AutoVue checks if a streaming file rendition exists inside Documentum. If there is one, 
AutoVue checks it out instead of the native file.

Every time you view a file with AutoVue and you close the client or view another file, AutoVue automatically 
generates a streaming file and checks it into Documentum as a rendition of the original format.
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VueLink Features
This section covers the features that VueLink adds to AutoVue Client/Server Deployment.

Viewing Documents
To view documents from within Documentum and from within AutoVue, follow the appropriate instructions for 
Webtop.

Viewing a Document in Documentum Webtop
1 Launch your Web browser and go to the Webtop home page.

Example: http://host:port/webtop

2 Enter your username and password.

3 From the navigation tree, select the folder from where you want to view a file.

4 Right-click the file and then select AutoVue.

AutoVue client loads the file.
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Note: You can also launch AutoVue by selecting the file, then from the File menu select AutoVue.

Note: 

• To view a file from a local disk or network drive, click File Open  to select a file. The selected file displays 

in AutoVue.

• The Markup Indicator  on the left side of the AutoVue status bar indicates that one or more Markup files are 

associated with the document you are viewing.

• A resource icon  on the left side of the AutoVue status bar indicates that one of the components required to 
accurately and fully display the document is missing. Resources consist of fonts, External Reference files 
(XRefs), and other resources. Click this icon for the details about the missing information.

• If a document has other files associated with it, as is the case with XRefs, AutoVue checks out all the associated 
files as well. If Cadtop integration between AutoCAD and Documentum is in use, then AutoVue checks out the 
latest XRefs if the reference type is set to “Dynamic” in Cadtop. If the reference type is set to “Static,” AutoVue 
checks out a specific revision of XRefs.

Virtual Documents
Oracle VueLink for Documentum supports the XRef schema defined as virtual documents. If the relationship 
between the base file and the XRef file is defined, VueLink downloads and displays all XRefs for the base document.
Oracle Corp.



10 Oracle VueLink 19.3.2 for Documentum
Viewing multiple files in Documentum Webtop
Several files can be viewed simultaneously in Documentum Webtop. To view multiple files, do the following:

1 From the navigation tree, select the folder from where you want to select the files. Select multiple files in the 
folder.

2 Right-click, and select AutoVue from the resultant menu.

The selected files are opened in separate applet windows.

Note:  The files are opened in the order of file selection order (not in alphabetical order). The open files will be 
properly arranged, visually one applet window will not be hiding another.

Viewing files from Remote Locations
 When viewing a file as a user from a remote location, if the file is available at the remote location, user should be 
able to view the file. If the file is not available at the remote location, the primary server can download the file to the 
remote location, and you can view the file from the remote location.

The scenarios in which the user can view files from remote locations are illustrated in the following examples:

Example 1:

A document (e.g. AutoCAD 2D) is inserted by the user A (publisher) in primary site (Milano) and workflow for 
review is initiated.

The user B (reviewer) in remote site (Singapore) is reviewing the document and adding his comments as markup. The 
user B will be able to save the markup file to the primary site.

The user C (reviewer) in Milano is also reviewing the document and is adding comments as markup. This user will 
also be able to save the markup file to the primary site.

The user D (consolidator) in Milano is accessing all markups. The user D creates a consolidated markup, and sends 
request of change to user A. The markups from users B and C will be consolidated properly. Each user can now 
successfully retrieve the consolidated markup file.

Example 2:

A document (e.g. AutoCAD 2D) is inserted by user A (publisher) in remote site (Singapore) and workflow for review 
is initiated.

The user B (reviewer) in Singapore is reviewing the document and is adding comments as markup. The markup will 
be saved at the remote site and then synched to the primary site.

The user C (reviewer) in primary site (Milano) is also reviewing the document and is adding comments as markup. 
The markup will be saved at the primary site and then synched to the remote site.

The user D (consolidator) in remote site (Singapore) is accessing all markups and creates a consolidated markup and 
sends request of change to user A. The markups from users B and C will be consolidated properly. Each user can now 
successfully retrieve the consolidated markup file.
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Viewing Renditions in Documentum for Webtop
AutoVue displays all renditions from the list of supported file formats.

1 Right-click the file, then select View then Renditions.
The available renditions appear.

2 Right-click the rendition you want to view and select AutoVue.

AutoVue client launches and displays the file you selected.

Viewing Multi-Content Documents
Multi-content documents contain several files known as Content files. To view a content file in a multi-content 

document, from the AutoVue toolbar, select either First Document , Previous Document , Next 

Document , or Last Document .

Viewing Pages in a Multi-Page Content File
1 Display a file in AutoVue.

2 From the View menu, select Page.

3 Select Next, Previous, or Page Number.

If you selected Page Number dialog box appears. Enter the page number and click OK.
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Accessing Files Stored in the Docbase from 
AutoVue
AutoVue provides two ways to access files that are in the Docbase from within the AutoVue window: DMS Browse 
and DMS Search. You can use these ways to select files from within the repository when you need to open files for 
viewing, comparison, cross-probe, Mockup, batch printing or Overlays

If any operation requires you to open files, the File Open dialog box lets you search or browse the repository.

Note: 
• To open files that are on the local file system, from the File menu, select Open Local File in the AutoVue client.
• To open URLs from the AutoVue client, from the File menu, select Open URL and type the URL you want to 

display.

DMS Search
1 From the File Open dialog box, click the DMS Search.

A dialog box appears that lets you specify a search criteria.

2 To search for a file in the DMS, enter the full Name, Title and/or Author of the file in the DMS search dialog box. 

3  When you finish specifying your search criterion, click Search.
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4 AutoVue looks for all documents in the repository that match the search criteria and populates the Search results 
section with the search results.

5 Select a file from the Search results section and click Open to display the file in AutoVue.
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DMS Browse
1  From the File Open dialog box, click the DMS Browse. 

A dialog box appears that lets you browse through the repository.

2 Browse through the repository and click OK to select a file.
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Markups
The three types of Markup files are normal Markups, consolidated Markups, and Master Markups.

• Normal Markups: The default Markup when using a brand new setup.
• Consolidated Markups: You can load several files simultaneously and edit them to create a consolidated 

Markup where the contents of all files consolidate to display as one file. This type of Markup is especially 
helpful when you want to group reviews from various individuals to forward collectively to another person or 
group of reviewers.

• Master Markups: Markup files that display automatically when you open a document. This type of Markup 
alerts the viewer that important changes were made to the document content. This benefits the workflow cycle 
when changes to a document need to be noted but the document itself has not been modified in the authoring 
application.

For additional information on markups refer to the Oracle AutoVue, Client/Server Deployment User’s Manual.

Creating Markups
To create a Markup file:

1 View a file that you want to markup.

2 From the Markup menu, select New.
AutoVue enters Markup mode and a new Markup file appears in the Markup Navigation Tree.

From the Markup Properties toolbar, you can also click New Markup .

Creating Stamp
The Stamp markup entity lets you create a stamp that includes document and user information (metadata) pulled 
directly from the backend DMS system. 

To design an Stamp, you must use the Design Stamp tool that is included with the AutoVue Client/Server 
Deployment Installation. To launch the tool, go to the <AutoVue Client/Server Deployment Installation>\bin folder 
and double-click designer.bat. 

For detailed information on how to create an Stamp, refer to the Oracle AutoVue, Client/Server Deployment User’s 
Manual.

Saving a New Markup File
To save a new Markup file:

1 From the Markup menu, select Save. 
The Save Markup File As dialog box appears displaying the Markup Information that you entered when creating 
the markup.

Note: From the Markup Properties toolbar, you can also click Save Markup .

2 In the Name field, enter a name consisting of any combination of characters or numbers.

3 In the Title field, enter a title (optional) for the markup.

4 Select the Markup Type from the list.

5 Select the folder where you want the Markup file saved from the Folder list.

6 Set Keep Permanent to true to automatically promote Markups to newer revisions of the base document. 
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7 Click OK.
The Markup file is saved. The markups and the Markup file remain displayed in the workspace and in the 
Markup Navigation tree.

Saving Markups When closing AutoVue Browser
In the event you do not explicitly save new markups or modified existing markups, the browser for AutoVue 
automatically prompts you to save the markups before the window closes.

Opening Markup Files
To open a Markup file:

1 View a file that has existing markups.

2 From the Markup menu, select Open.

The Markup Files dialog box appears.

Note: From the AutoVue toolbar, you can also click Open Markup(s) , or from the bottom-left corner of 

the status bar, you can click Markup Indicator . 

Note: If the Markup Indicator icon does not display, then the file you opened has no existing markups associated 
to it.

3 From the Markup list, select the check box next to Markup file you want to open. 

Note: If you select more than one Markup file, the Active Markup menu lets you select which one of them is 
initially active.

4 Click OK. 

The selected markup or markups appear in the workspace on top of the original file.

When you select more than one Markup file, the markups display simultaneously.

Promoting Markups
It is possible to promote Markups from an earlier version of a document to the current version. When Markups are 
promoted, they are saved against the new version of the document.

1 From the Markup menu, select Open.

The Markup Files dialog box appears.

Note: From the AutoVue toolbar, you can also click Open Markup(s) , or from the bottom-left corner of 

the status bar, you can click Markup Indicator . 

Note: Some columns were narrowed to show the Version column.

2 To display the Markup files from previous versions of the base file, select All revisions.

The previous Markup files are displayed for the previous version of the base file.

3 Select one Markup file from the previous version and click OK.

The Markup file you selected is shown with the current version base file.

Then when you save the selected Markup (with or without any modification), it is saved as the Markup of the 
current base file version.

4 From the Markup menu, select Open.
If Markups exist for the document, the Open Markup dialog box appears.
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5 Select All revisions.
All Markups from all previous versions of the document are now displayed.

6 Select the Markup that has to be promoted.

7 Click OK.

The document is now opened in Markup mode and the selected Markup is displayed.

8 From the Markup menu, select Save as.

The Save dialog box appears.

9 Specify a name for the Markup and save.

The Markup is now saved with the current version of the document.

Deleting Markups
1 After displaying a file with AutoVue, from the Markup menu, select Open.

The Markup Files dialog box appears.

Note: From the AutoVue toolbar, you can also click Open Markup(s) , or from the bottom-left corner of 

the status bar, you can click Markup Indicator . 

2 Select one or more Markups from the list.

3 Click Delete.

4 At the prompt, click Yes to confirm the deletion of the desired Markups.

The selected Markups are deleted from the list of Markups in the Open Markup dialog box.

The Open Markup dialog box now displays the remaining Markup files.
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Consolidating Several Markups
The Consolidate option allows you to create a new Markup that combines copies of selected parts of different 
Markups. This option is available only if multiple Markups are loaded. During the review cycle consolidation 
simplifies document revisions by providing the author with one consolidated Markup rather than several Markup 
files.

To consolidate several Markups:

1 After the selected file displays with AutoVue, from the Markup menu, select Open. The Markup Files dialog 
box appears.

Note: From the AutoVue toolbar, you can also click Open Markup(s) , or from the bottom-left corner of 

the status bar, you can click Markup Indicator . 

2 Select a Markup file to view.

3 Select the active Markup file.

Note: Your new Markups will be saved to the active Markup you selected.

4 Click OK.

All the selected Markup files are simultaneously displayed.

5 From the Markup menu, select Consolidate.
The Consolidated Markups dialog box appears

6 Enter the Name of the consolidated Markup file.

7 From the Folder list, select the location to save the Markup file.

8 Set Keep Permanent to True or False.

9 Select the Markup layers you want to consolidate.

10 If you wish to display this consolidated Markup file as the active Markup file and close the other Markups once 
the consolidation is complete, select the Open as active markup and hide the others check box.

11 Click OK.

The consolidated Markup file is saved.
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Saving as Master Markup
AutoVue tags Markup files as normal, consolidated or master. Master Markups are immediately displayed when their 
base document is displayed. When viewing a document, Master Markups are automatically loaded and displayed in 
Markup mode. Although non-owners can view Master Markups, they are not able to change the Master Markups or 
create their own Markups based on them.

To save a newly created Markup file as a Master Markup:

1 After you have finished marking up a document, from the Markup menu, select Save or Save As.

The Save Markup File As dialog box appears.

2 Enter the Markup Name.

3 For Markup Type list, select master.

4 Click OK.

The Master Markup file is created and stored in the Markup database.

Now when another user logs on and views this file, AutoVue Markup mode automatically launches, loads your 
Master Markups and displays them.

Printing Document Attributes as Headers, Foot-
ers, or Watermarks
With AutoVue, it is possible to print document attributes in a header, footer or as a watermark.

1 From AutoVue, from the File menu, select Print.

The Print Properties dialog box appears.

2 Customize the Print Properties.

Headers/Footers
This group defines the headers and footers to be included on every printed page of the document.

1 Click the Headers/Footers tab.

2 Enter text in the Header and Footer boxes and/or choose from the Insert Code list box to set the information for 
headers and footers. The list of insert codes are:

•   %f: Full path of document
•   %v: Document Drive
•   %d: Document Directory
•   %b: Document Base name
•   %e: Document file extension
•   %n: Total document pages
•   %p: Current page number
•   %N: Total tiled-pages
•   %P: Current tile number
•   %Y: Date: Year
•   %M: Date: Month
•   %D: Date: Day
•   %W: Date: Day of week
•   %H: Time: Hour
•   %U: Time: Minute
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•   %S: Time: Seconds
•   %r: New line
•   %F: Native Print Settings (Excel)

3 When you have finished, click OK.

Watermarks 
A watermark prints faintly and transparent on the current document's contents. With the Watermarks group, the 
watermark is defined, as it will appear on the printed document.

1 Click the Watermarks tab.

2 Enter text in the Watermark Text box and/or choose from the Insert Code list box to set the information for 
Watermark. The text displays as it will appear on the document.

3 Click Set Font to customize the font.

4 When you have finished, click OK.

Converting a Document to Other Formats
You can use AutoVue to convert documents to other formats such as TIFF and then check in the converted document 
back into Documentum as a rendition of the original.

Note: TIFF, PDF, and BMP are the currently supported formats for saving as a rendition.

1 Display a document with AutoVue.

2 From the File menu, select Convert.

The Convert dialog box appears.

3 From the Convert to Format drop-down list, select the TIFF format.

4 Check the Rendition option under Output.

5 Modify any other options if you need to.

6 Click OK.

File conversion begins. AutoVue converts the file to the TIFF format and checks it into Documentum as a 
rendition of the original file.

Comparing Files
With the Compare feature, documents of the same type (raster or vector or 3D) are visually compared. The two 
selected files are simultaneously displayed in their own windows with the comparison findings displayed in a third 
viewing window. This feature is very useful for finding similarities and differences in revisions of a drawing.

1 After displaying a file with AutoVue, from the Analysis menu, select Compare.

The Compare dialog box appears.

2 To compare with a previous version of a document, select a version from the Document versions list.

Note: If you want to a select file through DMS Search, DMS Browse, or Browse instead of selecting a version 
from the Document versions list, you must to deselect the Document Versions check box.

3 To search through the Documentum Docbase, click DMS Search. Specify a search criteria and select a file from 
the Search results.

4 To browse through Documentum and select a file, click DMS Browse. The DMS Browse dialog box appears. 
Browse through the DMS and select a file.
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5 To select a local file, click Browse. Browse through the local file system and select a file.

6 To specify a URL, type in the URL in the File Name field.

7 Click OK after you select a file.

8 AutoVue displays the files in comparison mode.

AutoVue displays three windows: the first contains the original document; the second contains the version to compare 
against; and the third window contains the comparison results. 

The comparison result window uses color to communicate the result of the file comparison:

•   Green is for additions.
•   Red is for deletions.
•   Blue is for no change.

Cross Probing
AutoVue lets you specify files saved in the docbase for crossprobing.

1 Display a document with AutoVue.

2 From the Analysis menu, select Cross Probe.

The Select Files for Cross Probing dialog box appears.

3 To add files, click Add File.

4 The File Open dialog box appears.

5 Click Browse to select a local file. Browse through the local file system and select a file.

6 Click DMS Browse to select a file from the docbase. Browse through the DMS and select a file. 

7 Click DMS Search to search the docbase for a file. Select a file from the search results.

8 To specify a URL, type the URL in the File Name field.

9 Click OK when you finish selecting a file.

For additional information on accessing Docbase, using DMS Browse and DMS Search, refer to section Accessing 
Files Stored in the Docbase from AutoVue

MockUp
With AutoVue, it is possible to import 3D files from Docbase into the current AutoVue window.

1 View a 3D document from Documentum Webtop in AutoVue.

2 From the File menu, select Import file for Mockup.

The Import Design dialog box appears. 

3 To add files, click Add. The File Open dialog box appears.

4 To select a file from the Docbase repository, click DMS Browse. The DMS Browse dialog box appears. Browse 
through the DMS and select a file.

5 To search through the Docbase repository, click DMS Search. Specify a search criteria and select a file from the 
Search Results.

6 To select a local file, click Browse. Browse through the local file system and select a file.

7 To specify a URL, type in the URL in the File Name field.

8 Click OK after you select a file.
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Batch Print
With AutoVue, it is possible to print a set of files in a single batch. It is possible to select files that are in the 
repository to add to the list of files to be printed.

1 From the File menu, select Batch Print. 

The Batch Print dialog box appears.

2 Click Add to add files to the List of files to be printed. The File Open dialog appears.

3 To select a file from the Docbase repository, click DMS Browse. The DMS Browse dialog box appears. Browse 
through the DMS and select a file.

4 To search through the Docbase repository, click DMS Search. Specify a search criteria and select a file from the 
Search Results.

5 To select a local file, click Browse. Browse through the local file system and select a file.

6 To specify a URL, type in the URL in the File Name field.

7 Click OK after you select a file.

8 The selected file(s) appear in the List of Files to be printed. To print these files, click Print.

For additional information on accessing Docbase, using DMS Browse and DMS Search, refer to section Accessing 
Files Stored in the Docbase from AutoVue

File Overlays
With AutoVue, it is possible to specify a file saved in the Docbase repository for an overlay.

1 Open the file that you want to use as the base file for the overlay.

2 From the File menu, select Import File as Overlay.
The Overlays dialog box appears.

3 Click Add.
The Please Select an Overlay File dialog box appears.

4 Select a file to overlay and then click Open.

5 To add a another file, repeat steps 3 through 4.

6 When done, click OK.
The base file is displayed with the selected overlay files on top of it.

For additional information on accessing Docbase, using DMS Browse and DMS Search, refer to section Accessing 
Files Stored in the Docbase from AutoVue

Mobile Pack
Using the AutoVue Mobile feature in AutoVue, you can create a Mobile Pack. The Mobile Pack includes the native 
file or streaming file, metadata, Stamp designs, all reference files (XRefs), and associated markups. Optionally, you 
can include renditions such as TIFF or PDF. 

For information on creating a Mobile Pack, refer to the “Creating a Mobile Pack” chapter of the Oracle AutoVue, 
Client/Server Deployment User’s Manual.

When you are finished working with the Mobile Pack, you can update your changes to the backend DMS system. You 
can synchronize all of the markups created in the Mobile Pack to your backend system. These markups will be 
associated with the file in the backend system from which you originally created the Mobile Pack.
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For information on updating from Mobile Pack, refer to the “Updating from Mobile Pack” chapter of the Oracle 
AutoVue, Client/Server Deployment User’s Manual.

Internationalization (i18n)
To change the locale and language setting of VueLink-related dialogs in AutoVue, change the language setting in 
your browser to desired language.

If the corresponding language resource is included in AutoVue, it will be used automatically. Otherwise, the default 
language setting (English) will be used.
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Feedback
Oracle products are designed according to your needs. We would appreciate your feedback, comments or suggestions. 
If at any time you have questions or concerns regarding Oracle VueLink for Documentum, call or email us. Your 
input is an important part of the information used for revision.

General Inquiries

Sales Inquiries

Customer Support

Telephone: +1 514-735-3219

Fax: (514) 735-6440

E-mail: autovuesales_ww@oracle.com

Web Site: http://www.oracle.com/applications/autovue/index.html

Telephone: +1 514-735-3219 or 1-800-361-1904

Fax: (514) 735-6440

E-mail: autovuesales_ww@oracle.com

Web Site: http://www.oracle.com/support/index.html
Oracle Corp.
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